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Introduction to EndNoteWeb & CiteULike 
January 2008 

 
EndNoteWeb and CiteULike are reference management tools that allow users to save, organize, store 
article PDFs, and format references in Word for research projects.  Both EndNoteWeb and CiteULike 
export to EndNote desktop or Reference Manager for formatting references in papers, dissertations, or 
manuscripts and bibliographies.  Store article PDFs in CiteULike to read or print later.  
 

Class Objectives: 
1.  Register for or download necessary components 
to get started. 
2. Execute basic functions:  

a. Create a new library;   
b. Create a new reference; 
c. View, edit, or delete a reference;  
d. Sort or organize references; 
e. Save a document with a reference;  
f. Search for a set of references, 
g. Create a bibliographic citation for a 
reference. 

3. Search for references in PubMed or other 
recognized sites and save a reference to your 
library. 

4. Export references for use with EndNote 
desktop and Cite While You Write in MS 
Word  

5. Collaboration Features 
6. CiteULike – share references and store 

PDFs for later use 
 
 

 

Overview: 
 

EndNoteWeb is a web-based reference management tool.  You can save references from websites such 
as PubMed, tag the references with keywords, create bibliographies, or Cite While You Write in MS 
Word.  You can access your library from any computer with an internet connection.   It is available 
because the university leases access to Web of Science, which is owned by the same company as 
EndNoteWeb.  You cannot store a PDF or other document in EndNoteWeb. 
 

CiteULike allows users to save references from websites such as PubMed, tag the references with 
keywords, save a copy of a pdf, and share your library with other CiteULike users or copy references 
from their libraries to your library. You can access your library from any computer with an internet 
connection.  CiteULike has limited output options. Your CiteULike library can be exported in RIS 
format, then imported into EndNoteWeb or EndNote desktop or Reference Manager to format a paper in a 
specific bibliographic style, such as AMA style. 
 
 

A Note about Connotea: Connotea helps track references for websites or other sources, but does not 
allow PDF storage.  Due to time limits, Connotea will not be discussed.  
 
A Note about Zotero: Zotero is an add-on to Mozilla Firefox browser that must be installed on your 
computer. Using Zotero, you can save references from websites such as PubMed, store PDFs or other 
files with references, tag the references with keywords, and create bibliographic citations in AMA, APA, 
Nature, or NLM style to copy and paste into papers, or use a toolbar in Word to insert citations. You can 
export your library in RIS format for importing into EndNoteWeb or EndNote desktop or Reference 
Manager.  Due to time limits, Zotero will not be discussed. 
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 EndNoteWeb http://endnoteweb.com/  
Save References, Write Papers in a Preferred Style 

CiteULike  http://www.citeulike.org/ 
Save & Share References, Store PDFs 

Where to register Go to http://hsclibrary.uchsc.edu/databases/by-title/W and 
click on Web of Science, then click on Register under 
Customize Your Experience on the right hand side of the 
screen.  This will ensure access to the Health Science 
Library’s full version of EndNote Web  

http://www.citeulike.org/register 

Software Notes Works with IE or Firefox Works with IE or Firefox 

Help & Support Tour http://www.myendnoteweb.com/EndNoteWeb/ 
1.1/release/help/ENW/ht_tourintro.htm  
Help http://www.myendnoteweb.com/EndNoteWeb/ 
1.1/release/help/ENW/h_toc.htm  
 Customer Support http://www.endnoteweb.com/ 
support/enwebsupport.asp 

FAQ http://www.citeulike.org/faq/all.adp  
Discussion List http://www.citeulike.org/pipermail/ 
citeulike-discuss/  
 

Installation Go to 
http://www.myendnoteweb.com/EndNoteWeb/1.3/release/E
ndNoteWeb.html?func=downloadInstallers&  Downloads 
are available for IE, MS Word, and Firefox users. 

Install a bookmarklet to save references to your library  
http://www.citeulike.org/post 

Compatible Databases Click on Collect and  Customize this list to select prefered 
resources to search. We recommend:  Library of Congress, 
Natl Lib of Med, and PubMed 

Use the  button in Web of 
Science for direct export to your EndNoteWeb library 

See list of sites at http://www.citeulike.org/post 

Using Online Search After selecting prefered resources to search (instructions 
above), click on Collect and select a resource to search, 
such as PubMed 

Not applicable. 

Import References from 
PubMed 

Yes, see instructions on page 5 below Yes, see instructions on page 5 below 
 

Searching your library Most fields in all references are searchable. Locating a citation is dependent upon author names and keyword 
tags 

Attachments or document 
storage 

No document storage is available at this time.  You can put 
a link to a file on your computer in the reference’s Notes 
field, to remind yourself where you keep a copy of the 
article.  

Store a pdf document with your reference, eliminating the need to 
maintain files on your computer. 
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Collaboration Export citations as an RIS file for use in EndNote 

desktop or Reference Manager or CiteULike users to 
import into their libraries. 

Use the tag clouds, filter, and subject browsing on the home 
page to find references from other users libraries. Copy 
references from other libraries into your library.  

Keyword tagging Keywords are added with references if indexed in the 
resource from which they are being saved.  Keywords 
can also be added manually by clicking on the title of a 
reference, then on Edit. 

Thorough tags are key to sharing and finding resources in your 
library.  

Create a Bibliography Click on Format, then Customize this list to select 
favorite styles. Then Export a bibliography in the 
desired style.  APA 5th and J Amer Medical 
Association are the two styles required at UCHSC, but 
hundreds of others are also available. 

No bibliography creation is available.  Export in RIS and 
import into EndNoteWeb, or EndNote desktop (available in 
the Health Sciences Library 3rd Floor Computer Lab) and use 
MS Word to generate a bibliography.  

Export formats Many export formats are available. Click on Format, 
then Export References 

Export to EndNote in RIS format or in BibTeX format. 

Import formats Import RIS, delimited text, and many other formats by 
clicking on Collect, then Import References 

Import from BIbTeX 

Importing Citations from EndNote   • In EndNote, go to the drop-down output style list on 
the toolbar, and choose Select Another Style. 
Highlight and choose the appropriate output style: 
RefMan (RIS). 

• Go to the File menu and use Export to export  your 
library to a plain text file. 

• Click on Collect, then Import References in 
EndNoteWeb, then browse and select your text 
file, then select RefMan (RIS) from the menu. 

CiteULike cannot import from EndNote.  

Exporting Citations into EndNote • Follow the instructions on page 4 below “Backing 
Up Your Library”, to export your EndNoteWeb 
Library 

• In EndNote, click on FILE / IMPORT 
• Locate the Exportlist text file on your computer 
• Select Reference Manager RIS as the Import 

Option 
• Select Discard Duplicates, then click on IMPORT 

• While viewing an individual citation or your entire 

library, click on the  button 
• In EndNote, click on FILE / IMPORT 
• Locate the Exportlist text file on your computer 
• Select Reference Manager RIS as the Import Option 
• Select Discard Duplicates, then click on IMPORT 

Updates New features will be announced at the EndNoteWeb 
homepage.  You may need to download updates to the 
browser toolbar for capturing references. 

New features or technical updates are discussed at the user 
discussion list and distributed by email to subscribers.  

Writing Papers Use the EndNoteWeb toolbar in MS Word to insert and 
format citations in your paper 

N/A – Export references as an RIS document and import into 
EndNoteWeb or EndNote desktop  to use MS Word. 
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INSTRUCTIONS: 
Backing Up Your Library 
EndNoteWeb CiteULike 
On a regular schedule, export a copy of your library to a 
file that can be used to restore your library, should it 
ever be lost or damaged.   
• To export your library, click on Format, then Export 

References, and select Ref Man (RIS)  
• Click on Export and select All References in My 

Library  
• Select Export Style Ref Man (RIS) and click on 

Save To and save your Library to a flash drive, 
compact disk or network drive 

• Import a saved EndNote or EndNote Web Library at 
Collect / Import References, using the Ref Man 
(RIS) filter 

• http://www.citeulike.org/export.adp  
Export to EndNote in RIS format or save in BibTeX 
format 

 

Create a new library or folder: 
EndNoteWeb CiteULike 
• You are assigned one library when you register,  

create groups to organize your references  
• Click on Organize, then on the New Group button 
• Type the new group name in the box and click “ok” 
• Click Delete to remove a group from your 

EndNoteWeb  

• You are assigned one library when you register 
• Group your citations by using the same tag for  all 

articles on the same subject 
• Click View Recent on the left or on 

yourlibraryname at the top of the browser screen 
when you want to return to your library   

 

Create a new reference: 
EndNoteWeb CiteULike 
Click Collect, then New Reference, and type in the 
reference 

Click on Manually Post Article and complete the form 

 

View, edit, or delete a reference:  
EndNoteWeb CiteULike 
• Click on My References 
• Click the title for a reference, then on the Edit 

button, edit the reference, click on the Save button 
• Click on the checkbox next to a reference, then on 

the Delete button to delete the reference and click 
“ok” in the dialog box 

• Click on the hyperlinked title of a reference 
• Click on Edit Details, edit the reference, click on 

Update Details 
• Click on Delete this Post, then click on “ok” in the 

dialog box 

 

Sort or organize references: 
EndNoteWeb CiteULike 
• Sort by author, year, folder, or title by clicking on 

the column heading in the folder view 
• Click on My References, then click the checkbox 

next to references, then in the Add to Group menu, 
select New Group  

• Click on a tag or an author name to view other 
references with the same tag or author.  

• Use the  see everyone’s ___ link to see references 
from other users’ libraries on the same topic. 

• Browse all libraries at CiteULike by subject 
 

Search for a set of references: 
EndNoteWeb CiteULike 
Click on My References and use the Quick Search   Search all libraries at CiteULike for author, title, 

abstract, journal and tag 
 

Save a document with a reference: 
EndNoteWeb CiteULike 
Not available, but you can save a document to your 
computer and note where it’s saved in the EndNoteWeb 
reference. 

• Save a pdf to your desktop, then open the matching 
reference 

• Click on Browse, find the matching pdf, then click 
on Upload 

• Delete the pdf from your desktop 
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Search Online: 
EndNoteWeb CiteULike 
• Click on Collect and  Customize this list to select 

prefered resources to search. We recommend:  
Library of Congress, Natl Lib of Med, and PubMed. 

• Click on Collect, select PubMed (NLM), click on 
Connect 

• Type in concepts and select the appropriate PubMed 
fields (or use the default “Any Field”)  

• Click on Retrieve, and review the results. 
• Checkmark results and copy to an existing or new 

group. 

• Not available in CiteULike 

 

Save references from PubMed to your library: 
EndNoteWeb CiteULike 
• In PubMed, click to checkmark any reference you 

want to save to your library, then Send to Clipboard 
• Click on the Clipboard tab, change Display to 

MEDLINE, then click on Send to File and save your 
file as .txt to the computer desktop.  

• In EndNote Web, click on Collect, then Import 
References  

• Browse and find the saved file from PubMed,  
• Select PubMed (NLM) from the type of file menu, 

then click on the Import button.  

• Click on the author name to view a single PubMed 
citation in the Abstract display, then click on Post to 
CiteULike on the browser toolbar (see Installation 

above for instructions)   
• The reference will appear in your CiteULike library, 

edit, the Post Article 
• Use the browser Back button to return to your 

PubMed results list 
• Trouble? Try this: Click Related Articles". Your 

article will be at the top of the list. Click the author 
link. Then use the Post to CiteULike bookmarklet. 

 

Save a reference from Ovid to your library: 
EndNoteWeb CiteULike 
• In Ovid, click to checkmark any reference you want 

to save to your library 
• In the Results Manager at the bottom of the screen, 

lick on Selected Results, Complete Reference, 
Reprint/MEDLARS, then click on SAVE 

• In EndNote Web, click on Collect, then Import 
References  

• Browse and find the saved file from Ovid,  
• Select MEDLINE (Ovid)  from the type of file 

menu, then click on the Import button.  

This feature is not available in CiteULike 

 

Set up Output Style favorites for creating a bibliography: 
EndNoteWeb CiteULike 
• Click on Format, then Customize this list to select 

favorite styles. APA 5th and J Amer Medical 
Association are the two styles required at UCHSC. 

• This feature is not available in CiteULike 

 

Create a bibliography: 
EndNoteWeb CiteULike 
• Set up your Output Styles favorites (see above) 
• Check mark reference(s) and click  the Copy to 

Quick List button 
• Click on Format, select Quick List, then select a 

Bibliographic Style; Select a File Format, use RTF 
– Rich Text Format 

• Click on Save - open in Word, or save to your 
computer 

• This feature is not available in CiteULike, export in 
RIS format to EndNote to create a bibliography 
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Cite While You Write in EndNoteWeb 

 

A.  To view EndNoteWeb and EndNote desktop toolbars in 
MS Word   

1. While in Word, click on Tools/EndNoteWeb/Cite 
While You Write Preferences 

2. Click on the Application tab, click on EndNoteWeb 
3. Type your email address and password into the boxes 

provided.   
4. Check mark Remember my address and password. 

 

B. Insert a citation into a Word document (Have your 
EndNote Library open) 

1. Start Word. From the File menu, choose New. 
2. Select Blank Document and click on OK. 
3. Type in a sentence and position the curser at the end before the period, with a space before 

and after the cursor. 
4. From Word’s Tools menu, choose EndNoteWeb.  
5. Open Find Citation and search for a keyword or author in the Find box. You may select more 

than one citation by holding the CTRL key and clicking on each citation.  
6. Click on the Insert button. 

 

C.  Moving or Deleting a citation from a Word document 
Citations can only be deleted at the point of insertion.  This will prompt a re-ordering of your 
bibliography.  
1. Find the reference where it occurs in the text of your paper, i.e. the superscript number or 

parenthetical reference. 
2. Right click on the reference and click on Edit Citations(s). 
3. Select the citation from the list in the left-hand column.  
4. Click on the Remove and OK buttons to delete the citation.  

 

D.  Change the bibliography format 
1. Click on Word’s Tools menu, then EndNoteWeb, then choose Format Bibliography. 
2. Select the style required.  
3. Click OK to begin formatting the paper. 

 

E.  Sharing Word documents with other EndNote or EndnoteWeb users 
1. When sending a manuscript to an editor or publisher, use the Tools menu, then click on 

EndnoteWeb, then choose Remove Field Codes – this removes the underlying codes, but 
preserves the layout, allowing the publisher or editor to make copy changes 

2. If you are co-authoring a paper with someone who also is maintaining an EndNote Library 
you can send references to be added to the co-authors EndNote Library.  Select Tools, then 
EndNoteWeb, then Export Travelling Library.  Then you can both maintain an EndNote 
Library that is up-to-date with all the citations in your shared paper. 
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How to get help 

 
o Use the help files from EndNoteWeb & CiteULike (see Help & Support on page 2 of this 

handout.) 
 

o Send an instant message - http://hsclibrary.uchsc.edu/aal/   Available 9:00 a.m.- 5:00 p.m. 
Monday through Friday. 
 

o E-mail your question using the web form at http://hsclibrary.uchsc.edu/aal/  or directly to 
reference.library@uchsc.edu and get a response within 24 hours, usually sooner. 
 

o Come ask us in person. Talk to a reference librarian at the Service Desk during these hours: 
8:00 am - 6:00 pm Weekdays.  
 

o Consultations - http://hsclibrary.uchsc.edu/research-support/consult.php  Schedule a free 
research consultation in your office or in the library to learn more about our resources of for 
help with your database searching. Request a mediated literature search for a fee. 
 

o Search questions? Connection problems? Wireless connections? Library hours? Overdue 
fines? Card expired? Learning software? Call the Service Desk at 303-724-2152 
 

o Tutorials - http://hsclibrary.uchsc.edu/online-tutorials  
 

o Take a library class. Request a special class for yourself or a group. All classes are free to 
campus faculty, staff and students. Classes - http://hsclibrary.uchsc.edu/classes/   

 


